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Using Tools
Cisco Access Manager (CAM) provides a set of tools to help you to manage various 
features of your Cisco AccessPath system and System Controller. The tool set includes the 
several managers as described in the following sections:

• “Using the Template Manager” on page 5-1

• “Using the IOS Image Manager” on page 5-12

• “Using the Modem Firmware Image Manager” on page 5-30

• “Using the Configuration File Manager” on page 5-45

• “Using the Task Manager” on page 5-59

• “Using the User Account Manager” on page 5-67

Using the Template Manager
The Template Manager helps you to manage the CAM configuration templates. The 
Template Manager supports the following tasks:

• Importing a Configuration Template on page 8-6

• Editing a Configuration Template on page 8-8

• Deleting a Custom Configuration Template on page 8-10

The Template Manager lists all the available templates. The information displayed in the 
main Template Manager dialog box is independent of the device or container you might 
have selected in the Device Tree View. (See Figure 8-1.) 
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Using the Template Manager
Figure 8-1 Template Manager—Main Dialog Box

Table 8-1 lists and briefly describes each of the fields that display on the main dialog box 
of the Template Manager.

Table 8-1 Template Manager Fields

Field Name Description

number For informational purposes only.

Name Name assigned to the template file. CAM defines the names of 
the default template files. (See Table 8-2.) You define the names 
for custom configuration template files.
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Using the Template Manager
CAM configuration templates are text files that contain Cisco IOS command-line interface 
(CLI) commands and template variables that allow you to easily define configuration data 
for a device. CAM creates your configuration files by substituting the template variables 
with data derived from selections or entries you made at the various dialog boxes during the 
create and modify procedures for System Controllers and shelves. CAM then downloads 
these configuration files to the devices that make up your Cisco AccessPath system. 

You do not specify a configuration template for a stack. You specify a configuration 
template during the creation or modification of only System Controllers and shelves. You 
can also schedule when the download of the configuration is to occur. For details about the 
create and modify procedures, see the “Configuring System Controllers” section on 
page 4-42 and the “Shelf Configuration for System Controllers” section on page 5-20.

Note You cannot edit and save template files from the GUI onto the database if the 
template file exceeds 28K bytes; the file will be truncated to 28K bytes. However, you can 
import template files that are larger than 28K bytes from UNIX. 

Device Type Type of device for which the template can be used.

Last Modify The last time the template file was modified. This time should 
never change for default configuration template files, only for 
custom configuration template files.

Default Shows whether the template files is a default configuration 
template. Custom configuration template files can never be 
default configuration template files.

(Optional.) Description Description to help identify the template file.The description can 
be up to 128 characters in length.

Field Name Description
 Using Tools 8-3



Using the Template Manager
CAM supports two types of templates:

• Default configuration templates—Read-only templates provided with CAM to generate 
most of the configurations for the supported Cisco AccessPath systems. In most cases, 
your selections or entries made during the create and modify procedures provide the 
information needed for CAM to customize these default templates and download the 
completed configuration files to the shelves on your Cisco AccessPath system. See 
Table 8-2 for a complete list of CAM default configuration templates. See Appendix B, 
“Default Configuration Templates,” for complete versions of the default configuration 
templates provided in CAM.

• Custom configuration templates—Customer-created templates designed to add or 
change functionality built into the templates listed in CAM. You can create these 
templates by editing the default configuration templates and saving them with different 
file names. In most cases, the default configuration templates will meet your needs. 
However, if you have special requirements, consider creating a custom configuration 
template.

Note While you can create or modify a custom configuration template, you cannot 
create or modify the variables that come as part of the CAM default configuration 
templates. These variables are written in all capital letters and preceded by a pound sign 
(#). You can add or delete any CLI code, including CLI code that contains CAM 
variables, but you cannot edit these variables or create new ones.

All of the CLI code entered into a custom configuration template must be written in 
valid Cisco IOS syntax. Otherwise, when CAM attempts to download the configuration 
file, the shelf rejects the command.
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Default Configuration Templates
Default Configuration Templates
Table 8-2 lists the default configuration templates for each type of device.

Table 8-2 CAM Standard Configuration Templates

System Template Device

Cisco AccessPath-TS3 Cisco 3640 (3640-default.txt) Cisco 3640 Console 
Management Shelf (CMS)

Cisco 7206 without Catalyst 5002 
(7206-Entry-default.txt)

Cisco 7206 using two Switch 
Blade cards for switching

Cisco 7206 with Catalyst 5002 
(7206-default.txt)

Cisco 7206 using a 
Catalyst 5002 for its primary 
switching path

Cisco AS5300 
(AS5300-default-channelized.txt)

Cisco AS5300s using 
channelized T1 or E1

Cisco AS5300 
(AS5300-default-pri.txt)

Cisco AS5200s using PRI

Catalyst 5002 
(CAT5002-default.txt)

Catalyst 5002

Cisco-LS3 Cisco LS3 (3640-LS3-default.txt) Cisco minibundle system

Cisco System Controller Cisco 3640 (SC3640-default.txt) Cisco 3640 System Controller 
(SC)

Cisco AS5800 
(AS5800-default.txt)

Cisco AS5800
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Using the Template Manager
Importing a Configuration Template
You can create a custom configuration template using the Import feature in the Template 
Manager. 

To create a custom configuration template by importing:

Step Description

1 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform.

2 Click Template Manager. The Template Manager main dialog box appears. 
(See Figure 8-1.) 

3 Click Import. The Template Manager Import dialog box appears. 
(See Figure 8-2.) 

4 Enter the filename. The name of the file you want to import. This can be any 
custom configuration file that you have created.

Note All of the CLI code entered into a custom 
configuration template must be written in valid Cisco IOS 
syntax. Otherwise, when CAM attempts to download the 
configuration file, the System Controller or shelf rejects the 
command.

5 Enter a location. The location must be the full path name to the file you 
want to import. The file must be on the CAM server. It 
cannot be remote.

6 Select a device type. Specify the type of device to which the configuration file 
applies. You can select from any of the following device 
types:

• Cisco AS5300

• Cisco 7206

• Cisco 3640

• Catalyst 5002

• Cisco SC3640

• Cisco AS5800
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Importing a Configuration Template
Figure 8-2 Template Manager—Import Dialog Box

7 (Optional.) Enter a description 
of the configuration file you are 
importing.

The description can be up to 128 characters.

8 Click OK. CAM imports the specified configuration file and adds it 
to the templates listed on the Template Manager main 
dialog box.

You can now select this template when you create or 
modify this type of device.

Step Description
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Using the Template Manager
Editing a Configuration Template
You can create a custom configuration template using the Edit feature in the Template 
Manager. 

To edit a custom configuration template:

Step Description

1 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform.

2 Click Template Manager. The Template Manager main dialog box appears. (See 
Figure 8-1.) 

3 Select the template you want to 
edit and click Edit.

The Template Manager Edit dialog box appears. (See 
Figure 8-3.) 

4 Modify the template to meet 
your requirements.

While you can create or modify a custom configuration 
template, you cannot create or modify the variables that 
come as part of the CAM default configuration templates. 
These variables are written in all capital letters and 
preceded by a pound sign (#). You can add or delete any 
CLI code, including CLI code that contains CAM 
variables, but you cannot edit these variables or create new 
ones.

All of the CLI code entered into a custom configuration 
template must be written in valid Cisco IOS syntax. 
Otherwise, when CAM attempts to download the 
configuration file, the System Controller or shelf rejects 
the command.

5 Edit the File Name field to give 
this template a new name and 
the description field to give this 
template a new description. 

You can give this template a new name. If you do not give 
it a new name, CAM updates the existing template. The 
description can be up to 128 characters.

6 Click Save. You are returned to the Template Manager main dialog 
box. The list of templates includes the template you just 
created. You can now select this template when you create 
or modify this type of device.
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Editing a Configuration Template
Figure 8-3 Template Manager—Edit Dialog Box
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Using the Template Manager
Deleting a Custom Configuration Template
You cannot delete a default configuration template. You can only delete custom 
configuration templates that you have either imported or renamed and edited. In addition, 
a custom template cannot be deleted if it is currently used by a shelf.

Caution  If you delete a custom configuration template, you cannot recover it.

To delete a custom configuration template:

Step Description

1 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform.

2 Click Template Manager. The Template Manager main dialog box appears. (See 
Figure 8-4.) 

3 Select the template you want to 
delete.

It must be a custom configuration template.

4 Click Delete. You are returned to the Template Manager main dialog 
box. The custom template has been removed from the 
listed templates.
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Deleting a Custom Configuration Template
Figure 8-4 Template Manager—Main Dialog Box
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Using the IOS Image Manager
Using the IOS Image Manager
The IOS Image Manager provides device-dependent management functions. The IOS 
Manager supports the following tasks:

• Setting the Default IOS Image on page 8-15

• Importing an IOS Image on page 8-17

• Updating an IOS Image on page 8-19

• Updating All to Default IOS Image on page 8-21

• Updating System Controller on page 8-23

• Viewing the History of an IOS Image on page 8-26

• Deleting an IOS Image on page 8-28

The IOS Image Manager allows you to upgrade or restore a Cisco IOS image on a device. 
It checks the Cisco IOS images loaded on the shelves within a stack or System Controller. 
The IOS Image Manager compares the loaded version against the default image version. If 
the Cisco IOS images do not match, the IOS Image Manager reports the discrepancy. 

CAM provides autoverify and autoupdate capability as options. For more information 
about these options, see the “Setting UI Preference” section on page 3-1. 

The Cisco 3640, System Controller-3640, Cisco 7206, and Cisco AS5800 devices have two 
slots (slot0 and slot1) for Flash memory cards. CAM always uses slot0 as the default Flash 
memory device when loading Cisco IOS images to these devices. Be sure to have a Flash 
memory card inserted in slot0. Otherwise, CAM cannot successfully load the Cisco IOS 
image.

Figure 8-5 shows the main dialog box for the IOS Image Manager. 
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Using the IOS Image Manager
Figure 8-5 IOS Image Manager—Main Dialog Box
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Using the IOS Image Manager
The following table lists and briefly describes each of the fields on the main dialog box of 
the IOS Image Manager: 

Table 8-3 IOS Image Manager Fields

Field Name Description

number Number CAM assigns to the image when it imported into CAM. 
Starting number is 1.

Rel. No Release number you assign to the Cisco IOS image when you 
import the Cisco IOS image into CAM.

Device Type Type of device for which the image will be used.

(Optional.) Description Description of the image that helps to identify it. It can be up to 
255 characters in length.

File Name Name of the file that is imported. This name must match the 
name of the image file that resides on the TFTP server.

TFTP Server Name or IP address of the TFTP server on which the Cisco IOS 
image file resides. 

Default Specifies whether the Cisco IOS image is the default Cisco IOS 
image for the specified device type.

InUse Flag that indicates whether the Cisco IOS image file is currently 
in use, that is, used by any shelf. You cannot delete a Cisco IOS 
image that is currently in use.
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Setting the Default IOS Image
The IOS Image Manager provides different capabilities for groups, stacks, System 
Controllers, and shelves. The following table lists the available options:

Table 8-4 IOS Image Manager Option Summary

Setting the Default IOS Image
You can set the default Cisco IOS image for a device type across the entire CAM system. 
You can override this default for individual devices. This option is only available if you 
have selected the CAMROOT group in the Device Tree View. This option is not enabled 
for any other container or shelf.

Container/Device Option

CAMROOT • Setting the default Cisco IOS image

• Importing a Cisco IOS image

• Updating a Cisco IOS image

• Deleting a Cisco IOS image

User-defined group • Importing a Cisco IOS image

• Updating a Cisco IOS image

• Deleting a Cisco IOS image

Stack • Updating all shelves to default Cisco IOS 
image

System Controller • Updating all shelves to default Cisco IOS 
image

• Updating System Controller

• Importing a Cisco IOS image

• Updating a Cisco IOS image

• Viewing history of a Cisco IOS image

Shelf • Importing a Cisco IOS Image

• Updating a Cisco IOS Image

• Viewing history of a Cisco IOS image
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Using the IOS Image Manager
For a summary of the options available in the IOS Image Manager for containers and 
devices, see Table 8-4.

To set the default Cisco IOS image for a device type:

Step Description

1 Select CAMROOT from the 
Device Tree View.

 The default group.

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the CAMROOT group.

3 Click IOS Image Manager. The IOS Image Manager dialog box appears. (See 
Figure 8-5.) 

4 Select a Cisco IOS image from 
the list and click SetDefault.

You have successfully set the default Cisco IOS image for 
all devices of that type across the entire CAM system. 
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Importing an IOS Image
Importing an IOS Image
You can import a Cisco IOS image file for use by a group, System Controller, and shelf 
(including Cisco AS5800).

For a summary of the options available in the IOS Image Manager for containers and 
devices, see Table 8-4.

To import a Cisco IOS image:

Step Description

1 Select a group, System 
Controller, or shelf by clicking 
on its name in the Device Tree 
View.

The device for which you want to import a Cisco IOS 
image.

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the selected device.

3 Click IOS Image Manager. The IOS Image Manager dialog box appears. 
(See Figure 8-5.) 

4 Click Import Image. The Import IOS Image dialog box appears. 
(See Figure 8-6.) 

5 Enter an image file name. The name of the Cisco IOS image you want to import into 
CAM.

6 Enter the image file directory. The full path of your Cisco IOS image file on the TFTP 
server.

7 Enter the TFTP server address. The TFTP server IP address of your Cisco IOS image file.

8 Enter the release number. The release number helps CAM to verify that Cisco IOS 
images are consistent across devices.

9 Select the device type for 
which you are importing the 
Cisco IOS image. 

You can select a AS5300, AS5800, 7206, 3640, or SC3640 
if you selected a group in the Device Tree View. AS5300 
is the default. If you select a shelf in the Device Tree View, 
the device type defaults to the type of shelf selected.
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Using the IOS Image Manager
Figure 8-6 IOS Image Manager—Import Dialog Box

10 (Optional.) Enter a description 
of the Cisco IOS image you are 
importing.

You can enter up to 255 characters.

11 Click OK. You have successfully imported a Cisco IOS image into 
CAM. You are returned to the IOS Image Manager main 
dialog box. The image list now includes the newly 
imported Cisco IOS image.

Step Description
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Updating an IOS Image
Updating an IOS Image
Updating a Cisco IOS image allows you to update the Cisco IOS image for all the devices 
in the group of a particular type, System Controller, or shelf.

For a summary of the options available in the IOS Image Manager for containers and 
devices, see Table 8-4.

To update a Cisco IOS image for a System Controller, shelf, or all devices of a specific type:

Step Description

1 Select a group, System 
Controller, or shelf by clicking 
on its name in the Device Tree 
View.

The group of devices or device for which you want to 
update a Cisco IOS image.

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the selected device.

3 Click IOS Image Manager. The IOS Image Manager dialog box appears. 
(See Figure 8-5.) 

4 Select a Cisco IOS image from 
the list and click Update.

The Update IOS Image dialog box appears. 
(See Figure 8-7.) 

5 Click Yes or No to erase 
current Flash memory.

Click Yes, to erase the Cisco IOS image currently stored in 
Flash memory. It cannot be recovered. Click No, to have 
the Cisco IOS image currently stored in Flash memory 
reside concurrently with the image you have selected.

6 Click now or later to execute 
this task.

Click now if you want the Cisco IOS image updated 
immediately and skip to Step 10. Click later to schedule 
the update for a later time. If you click later, you must 
define task information.

7 Enter the time you want the 
update to take place.

You must ensure that there is a value in the year, month, 
day, hour, and minutes fields. It must be a time in the 
future. You must select a date, time, and task name. 

8 Enter a Task Name. You must enter a task name. It can be up to 16 
characters.You can manage the task through the Task 
Manager. After a scheduled task executes, you might need 
to refresh your system. See “Refreshing Your System” 
section on page 2-7 for details.
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Using the IOS Image Manager
Figure 8-7 IOS Image Manager—Update Dialog Box

9 Enter information in the 
Comment field.

You can enter any information about the task that you 
want. You can specify up to 255 characters.

10 Click OK. You have successfully updated the Cisco IOS image for a 
System Controller, shelf, or all the devices of the specified 
type. You are returned to the IOS Image Manager main 
dialog box.

Step Description
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Updating All to Default IOS Image
Updating All to Default IOS Image
Updating All to Default IOS image allows you to update all the shelves in the stack or 
System Controller to the Cisco IOS image that you have defined as the default. 

For a summary of the options available in the IOS Image Manager for containers and 
devices, see Table 8-4.

To update all to a default Cisco IOS image for all the shelves:

Step Description

1 Select a stack or System 
Controller from the Device 
Tree View.

The stack or System Controller for which you want to 
update information.

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the device selected in the Device Tree View.

3 Click IOS Image Manager. The IOS Image Manager dialog box appears. 
(See Figure 8-8.) 

4 Select a Cisco IOS image from 
the list and click Update all to 
default.

The Update Image dialog box appears. (See Figure 8-9.) 

5 Click Yes or No to erase 
current Flash memory.

Click Yes to erase the Cisco IOS image currently stored in 
Flash memory. It cannot be recovered. Click No to have 
the modem image currently stored in Flash memory reside 
concurrently with the image you have selected. For 
System Controllers, if there is more than one image in 
Flash memory, the Cisco IOS image must be erased first to 
successfully load the image. Therefore, this option is 
disabled if you have selected a System Controller from the 
Device Tree View. 

6 Click now or later to execute 
this task.

Click now if you want the Cisco IOS image updated 
immediately and skip to Step 10. Click later to schedule 
the update for a later time. If you click later, you must 
define task information.

7 Enter the time you want the 
update to take place.

You must ensure that there is a value in the year, month, 
day, hour, and minutes fields. It must be a time in the 
future. You must select a date, time, and task name. 
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Using the IOS Image Manager
Figure 8-8 IOS Image Manager—Update All Dialog Box

8 Enter a Task Name. You must enter a task name. It can be up to 16 
characters.You can manage the task through the Task 
Manager. After a scheduled task executes, you might need 
to refresh your system. See “Refreshing Your System” 
section on page 2-7 for details.

9 Enter information in the 
Comment field.

You can enter any information about the task that you 
want. You can specify up to 255 characters.

10 Click OK. You have successfully updated the Cisco IOS image for all 
the devices of the specified type. You are returned to the 
IOS Image Manager main dialog box. 

Step Description
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Updating System Controller
Figure 8-9 IOS Image Manager—Update Dialog Box

Updating System Controller
Updating a Cisco IOS image allows you to update the System Controller to the Cisco IOS 
image that you select from the list. 

For a summary of the options available in the IOS Image Manager for containers and 
devices, see Table 8-4.

To update the System Controller:

Step Description

1 Select a System Controller 
from the Device Tree View.

The System Controller for which you want to update 
information.

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the device selected in the Device Tree View.
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Using the IOS Image Manager
3 Click IOS Image Manager. The main System Controller dialog box appears. 
(See Figure 8-10.) 

4 Click Update System 
Controller.

The update System Controller dialog box appears. 
(See Figure 8-11.) 

5 Select a Cisco IOS image from 
the list.

The Cisco IOS image with which you want to update the 
System Controller.

6 Click Update image. The Update IOS image dialog box appears. 
(See Figure 8-11.) 

7 Click Yes or No to erase 
current Flash memory.

Click Yes, to erase the Cisco IOS image currently stored in 
Flash memory. It cannot be recovered. Click No, to have 
the modem image currently stored in Flash memory reside 
concurrently with the image you have selected. For 
System Controllers, if there is more than one image in 
Flash memory, the Cisco IOS image must be erased first to 
successfully load the image. Therefore, this option is 
disabled if you have selected a System Controller from the 
Device Tree View. 

8 Click now or later to execute 
this task.

Click now if you want the Cisco IOS image updated 
immediately. Click later to schedule the update for a later 
time. If you click later, you must select a date, time and 
task name. You can manage the task through the Task 
Manager. After a scheduled task executes, you might need 
to refresh your system. See “Refreshing Your System” 
section on page 2-7 for details.

9 Click OK. You have successfully updated the Cisco IOS image for all 
the devices of the specified type. You are returned to the 
IOS Image Manager main dialog box. 

Step Description
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Updating System Controller
Figure 8-10 IOS Image Manager—Main System Controller Dialog Box
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Using the IOS Image Manager
Figure 8-11 IOS Image Manager—Update System Controller Dialog Box

Viewing the History of an IOS Image
Viewing the history of a Cisco IOS image allows you to view all the records of changes that 
have been made to the Cisco IOS image for the System Controller or shelf (either System 
Controller shelf or stack shelf) that you select.

For a summary of the options available in the IOS Image Manager for containers and 
devices, see Table 8-4.

To view changes:

Step Description

1 Select a System Controller or 
shelf from the Device Tree 
View.

 The device for which you want to view history.
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Viewing the History of an IOS Image
2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the device.

3 Click IOS Image Manager. The IOS Image Manager dialog box appears. 
(See Figure 8-5.) 

4 Click View History. The History Image dialog box appears with records of all 
the changes to the Cisco IOS image for the selected 
device. (See Figure 8-12.) 

5 Click Done. You are returned to the IOS Image Manager main dialog 
box.

Step Description
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Using the IOS Image Manager
Figure 8-12 IOS Image Manager—History Dialog Box

Deleting an IOS Image
Deleting a Cisco IOS image removes it from the list of managed Cisco IOS images. It does 
not delete it from the devices onto which has been loaded.

For a summary of the options available in the IOS Image Manager for containers and 
devices, see Table 8-4.
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Deleting an IOS Image
To delete a Cisco IOS image from the list of managed images:

Figure 8-13 IOS Image Manager—Main Dialog Box

Step Description

1 Select a group by clicking on 
its name in the Device Tree 
View.

The group for which you want to delete the Cisco IOS 
image.

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the device selected in the Device Tree View.

3 Click IOS Image Manager. The IOS Image Manager dialog box appears. 
(See Figure 8-13.) 

4 Select a Cisco IOS image from 
the list and click Delete.

You have successfully deleted the Cisco IOS image from 
the list of managed Cisco IOS images. 
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Using the Modem Firmware Image Manager
Using the Modem Firmware Image Manager
The Modem Firmware Image Manager provides device-dependent management functions 
which allow you to upgrade or restore a modem image on a device. The Modem Firmware 
Image Manager supports the following tasks:

• Setting the Default Modem Image on page 8-33

• Importing a Modem Image on page 8-35

• Updating a Modem Image on page 8-37

• Updating All to Default Modem Image on page 8-39

• Viewing the History of a Modem Image on page 8-42

• Deleting a Modem Image on page 8-44

During the upgrade and restore operations, the Modem Firmware Image Manager checks 
the modem images loaded on the shelves within a stack and compares the loaded version 
against the default image version. If the modem images do not match, the Modem Firmware 
Image Manager reports the discrepancy. CAM provides autoverify and autoupdate options 
for checking purposes. For more information about these options, see “Setting UI 
Preference” section on page 3-1.

Figure 8-14 shows the main dialog box for the Modem Firmware Image Manager. 
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Using the Modem Firmware Image Manager
Figure 8-14 Modem Image Manager—Main Dialog Box

Table 8-5 lists and briefly describes each of the fields that display on the main dialog box 
of the Modem Firmware Image Manager. 

Table 8-5 Modem Firmware Image Manager Fields 

Field Name Description

number For informational purposes only.

Rel. No Release number you assign to the modem firmware image when 
you import it into CAM.
 Using Tools 8-31



Using the Modem Firmware Image Manager
Modem Type Type of modem for which the image will be used. The supported 
modem types are MICA and Microcom.

(Optional.) Description Description of the image that helps to identify it. It can be up to 
255 characters in length.

File Name Name of the file that is imported. This name must match the 
name of the image file that resides on the TFTP server.

TFTP Server IP address of the TFTP server on which the modem firmware 
image file resides. 

Default Specifies whether the modem firmware image is the default 
modem firmware image for the specified device type.

InUse Flag that indicates whether the modem firmware image file is 
currently in use by any shelf. You cannot delete a modem 
firmware image that is currently in use.

Field Name Description
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Setting the Default Modem Image
The Modem Firmware Image Manager provides different capabilities for groups, stacks, 
System Controllers, and shelves. Table 8-6 lists the available options.

Setting the Default Modem Image
You can set the default modem firmware image for a device type across the entire CAM 
system. You cannot override this default for individual devices. This option is only 
available if you have selected the CAMROOT group in the Device Tree View. This option 
is not enabled for any other group. 

For a summary of the options available in the Modem Firmware Image Manager for 
containers and devices, see Table 8-6.

Table 8-6 Modem Firmware Image Manager Option Summary

Container/Device Option

CAMROOT • Setting the default modem image

• Importing a modem image

• Updating a modem image

• Deleting a modem image

User-defined group • Importing a modem image

• Updating a modem image

• Deleting a modem image

Stack • Updating all to default modem image

Shelf (Cisco AS5300 
only)

• Importing a modem image

• Updating a modem image

• Viewing history of the modem image

System Controller, 
Cisco AS5800, 
Catalyst 5002, 
Cisco 7206, and 
Cisco 3640 

• None
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Using the Modem Firmware Image Manager
To set the default modem image:

Step Description

1 Select CAMROOT by clicking 
on its name in the Device Tree 
View.

The group for which you want to set the Cisco IOS image. 
You can only set the default modem image for 
CAMROOT.

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for CAMROOT.

3 Click Modem Image 
Firmware Manager.

The Modem Image Firmware Manager dialog box 
appears. (See Figure 8-15.) 

4 Select a modem image from 
the list and click SetDefault.

You have successfully set the default modem image for all 
devices of that type across the entire CAM system. 
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Importing a Modem Image
Figure 8-15 Modem Image Manager—Main Dialog Box

Importing a Modem Image
You can import a modem firmware image file for use by a group or shelf. After you import 
image files, they appear on a list from which you can select specific images to be 
downloaded onto the devices.

For a summary of the options available in the Modem Firmware Image Manager for 
containers and devices, see Table 8-6.
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To import a modem firmware image:

Step Description

1 Select a group or shelf by 
clicking on its name in the 
Device Tree View.

The group or shelf for which you want to import the 
modem image. 

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the selected group or shelf.

3 Click Modem Image 
Firmware Manager.

The Modem Image Firmware Manager dialog box 
appears. (See Figure 8-14.) 

4 Click Import Image. The Modem Image Import dialog box appears. (See 
Figure 8-16.) 

5 Enter an image file name. The name of the modem image you want to import into 
CAM.

6 Enter the image file directory. The full path of your modem image on the TFTP server.

7 Enter the TFTP server address. CAM provides its own TFTP server address in this field. 
However, if your TFTP server is remote, enter the TFTP 
server address in this field.

8 Enter the release number. The release number helps CAM to verify that modem 
images are consistent across devices.

9 Select the modem type for 
which you are importing the 
modem image.

You can select MICA or Microcom. MICA is the default.

10 (Optional.) Enter a description 
of the modem image you are 
importing.

You can enter up to 255 characters.

11 Click OK. You have successfully imported a modem image into 
CAM. You are returned to the Modem Image Manager 
main dialog box. The image list now includes the newly 
imported modem image.
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Updating a Modem Image
Figure 8-16 Modem Image Manager—Import Dialog Box

Updating a Modem Image
Updating a modem firmware image allows you to update the modem firmware image for 
all the modems in the group of a particular type. This option downloads the selected image 
onto the selected group or shelf.

For a summary of the options available in the Modem Firmware Image Manager for 
containers and devices, see Table 8-6.

To update a modem firmware image for all devices of a specific type:

Step Description

1 Select a group or shelf by 
clicking on its name in the 
Device Tree View.

The group for which you want to update the modem 
image. 
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2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the selected group or shelf.

3 Click Modem Image 
Firmware Manager.

The Modem Image Firmware Manager dialog box 
appears. (See Figure 8-14.) 

4 Select an modem image from 
the list and click Update.

The Modem Image Update dialog box appears. 
(See Figure 8-17.) 

5 Click Busy Out or Reload to 
determine when the modem 
image is updated.

Click Busy Out to update the modem image on Busy Out. 
Click Reload to update the modem image when the device 
reloads.

6 Click now or later to execute 
this task.

Click now if you want the Cisco modem image updated 
immediately and skip to Step 10. Click later to schedule 
the update for a later time. If you click later, you must 
define task information.

7 Enter the time you want the 
update to take place.

You must ensure that there is a value in the year, month, 
day, hour, and minutes fields. It must be a time in the 
future.you must select a date, time, and task name. 

8 Enter a Task Name. You must enter a task name. It can be up to 16 
characters.You can manage the task through the Task 
Manager. After a scheduled task executes, you might need 
to refresh your system. See “Refreshing Your System” 
section on page 2-7 for details.

9 Enter information in the 
Comment field.

You can enter any information about the task that you 
want. You can specify up to 255 characters.

10 Click OK. You have successfully updated the modem image for all 
the devices of the specified type. You are returned to the 
Modem Image Manager main dialog box.

Step Description
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Updating All to Default Modem Image
Figure 8-17 Modem Image Manager—Update Dialog Box

Updating All to Default Modem Image
Updating a modem firmware image allows you to update all the Cisco AS5300 shelves in 
the stack to the modem image that you have defined as the default. 

For a summary of the options available in the Modem Firmware Image Manager for 
containers and devices, see Table 8-6.

To update all to the default modem firmware image for all the shelves:

Step Description

1 Select a stack from the Device 
Tree View.

 The stack for which you want to update information.

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the device selected in the Device Tree View.
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3 Click Modem Image 
Firmware Manager.

The Modem Image Firmware Manager Update All dialog 
box appears. (See Figure 8-18.) 

4 Select a modem image from 
the list and click Update all to 
default.

The Modem Image Update dialog box appears. (See 
Figure 8-19.) 

5 Click Busy Out or Reload to 
determine when the modem 
image is updated.

Click Busy Out to update the modem image on Busy Out. 
Click Reload to update the modem image when the device 
reloads.

6 Click now or later to execute 
this task.

Click now if you want the Cisco IOS image updated 
immediately and skip to Step 10. Click later to schedule 
the update for a later time. If you click later, you must 
define task information.

7 Enter the time you want the 
update to take place.

You must ensure that there is a value in the year, month, 
day, hour, and minutes fields. It must be a time in the 
future. You must select a date, time, and task name. 

8 Enter a Task Name. You must enter a task name. it can be up to 16 
characters.You can manage the task through the Task 
Manager. After a scheduled task executes, you might need 
to refresh your system. See “Refreshing Your System” 
section on page 2-7 for details.

9 Enter information in the 
Comment field.

You can enter any information about the task that you 
want. You can specify up to 255 characters.

10 Click OK. You have successfully updated the modem image for all 
the devices of the specified type. You are returned to the 
Modem Image Manager main dialog box. 

Step Description
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Updating All to Default Modem Image
Figure 8-18 Modem Image Manager—Update All Dialog Box
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Using the Modem Firmware Image Manager
Figure 8-19 Modem Image Manager—Update Dialog Box

Viewing the History of a Modem Image
Viewing history of the modem firmware image allows you to view records of all the 
changes that have been made to the modem firmware image for the shelves that you select. 

For a summary of the options available in the Modem Firmware Image Manager for 
containers and devices, see Table 8-6.

To view changes made to the modem firmware image:

Step Description

1 Select a shelf from the Device 
Tree View.

The device for which you want to view history.

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the device selected in the Device Tree View.
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Viewing the History of a Modem Image
Figure 8-20 Modem Image Manager—History Dialog Box

3 Click Modem Image 
Firmware Manager.

The Modem Image Firmware Manager dialog box appears. 
(See Figure 8-14.) 

4 Click View History. The Modem Image History dialog box appears with records 
of all the changes to the modem image for the selected 
device. (See Figure 8-20.) 

5 Click Done. You are returned to the Modem Image Manager main 
dialog box.

Step Description
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Deleting a Modem Image
Deleting a modem firmware image removes it from the list of managed modem images. It 
does not delete it from the devices on which it has been loaded. 

For a summary of the options available in the Modem Firmware Image Manager for 
containers and devices, see Table 8-6.

To delete a modem firmware image from the list of managed images:

Step Description

1 Select a group by clicking on 
its name in the Device Tree 
View.

The group for which you want to delete modem firmware 
images.

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the device selected in the Device Tree View.

3 Click Modem Image 
Firmware Manager.

The Modem Image Firmware Manager dialog box 
appears. (See Figure 8-14.) 

4 Select an modem image from 
the list and click Delete.

You have successfully deleted the modem image from the 
list of managed modem images.
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Using the Configuration File Manager
The Configuration File Manager helps you to manage configuration files for System 
Controllers and shelves. 

Note You cannot edit and save (or save as) configuration files from the GUI onto the 
database if the configuration file exceeds 28K bytes; the file will be truncated to 28K bytes. 
However, you can import configuration files that are larger than 28K bytes from UNIX, as 
well as backup and download large files to a device.

The Configuration File Manager supports the following tasks:

• Importing a Configuration File on page 8-48

• Editing a Configuration File on page 8-50

• Updating a Configuration File on page 8-52

• Viewing History of a Configuration File on page 8-55

• Deleting a Configuration File on page 8-57

Figure 8-21 shows the main dialog box for the Configuration File Manager. You can refresh 
the information on the Configuration File Manager main dialog box by clicking the 
Refresh button.
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Figure 8-21 Configuration File Manager—Main Dialog Box
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Using the Configuration File Manager
Table 8-7 lists and briefly describes each of the fields that display on the main dialog box 
of the Configuration File Manager. 

Table 8-7 Configuration File Manager Fields

The Configuration File Manager provides different capabilities for groups, stacks, System 
Controllers, and shelves.

Table 8-8 lists the available options.

Field Name Description

number For informational purposes only.

File Name Name of the configuration file.

Last Modify The last time the configuration file was modified.

(Optional.) Description Description of the file to help you identify it. It can be up to 
128 characters in length.

In Use Name of the configuration file currently loaded on the device.

User Name Name of the user who has created or modified the configuration 
file.

Table 8-8 Configuration File Manager Option Summary

Container/Device Option

CAMROOT • none

User-defined group • none

Stack • none
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Importing a Configuration File
You can add configuration files to the list of files that can be selected using the Import 
feature in the Configuration File Manager. 

For a summary of the options available in the Configuration File Manager for containers 
and devices, see Table 8-8.

To add a configuration file by importing:

System Controller • Importing a configuration file

• Editing a configuration file

• Updating a configuration file

• Deleting a configuration file

• Viewing history of a configuration file 

Shelf (Cisco AS5300, 
Cisco AS5800, 
Catalyst 5002, 
Cisco 7206, Cisco 3640)

• Importing a configuration file

• Editing a configuration file

• Updating a configuration file

• Deleting a configuration file

• Viewing history of a configuration file 

Step Description

1 Select a System Controller or 
shelf from the Device Tree 
View.

The device for which you want to import a configuration 
file.

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the selected device.

3 Click Configuration File 
Manager.

The Configuration File Manager dialog box appears. (See 
Figure 8-21.) 

4 Click Import. The Configuration File Manager Import dialog box 
appears. (See Figure 8-22.) 

Table 8-8 Configuration File Manager Option Summary (Continued)

Container/Device Option
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5 Enter the file name. The name of the file you want to import. This can be any 
custom configuration file that you have created.

All of the CLI code entered into a custom configuration 
template must be written in valid Cisco IOS syntax. 
Otherwise, when CAM attempts to download the 
configuration file, the System Controller or shelf rejects 
the command.

6 Enter a location. The location must be the full path name of the file you 
want to import. The file must be on the CAM server.

7 (Optional.) Enter a description 
of the configuration file you are 
importing.

The description should provide information to help you 
identify the configuration file. The description can be up to 
128 characters.

8 Click OK. CAM imports the specified configuration file and adds it 
to the files listed on the Configuration File Manager main 
dialog box.

You can now select this configuration file when you create 
or modify this type of device.

Step Description
 Using Tools 8-49



Using the Configuration File Manager
Figure 8-22 Configuration File Manager—Import Dialog Box

Editing a Configuration File
You can create a custom configuration file using the Edit feature in the Configuration File 
Manager. 

For a summary of the options available in the Configuration File Manager for containers 
and devices, see Table 8-8.
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To create a custom configuration file by editing:

Step Description

1 Select a System Controller or 
shelf from the Device Tree 
View.

The device for which you want to edit a configuration file.

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the selected device.

3 Click Configuration File 
Manager.

The Configuration File Manager dialog box appears. 
(See Figure 8-21.) 

4 Select the configuration file 
you want to edit, and click 
Edit.

The Configuration File Manager Edit dialog box appears 
with the configuration file content. (See Figure 8-23.) 

5 Modify the file to meet your 
requirements.

All of the CLI code entered into a custom configuration 
file must be written in valid Cisco IOS syntax. Otherwise, 
when CAM attempts to download the configuration file, 
the System Controller or shelf rejects the command.

6 (Optional.) Change the file 
name and description of the 
file.

If the InUse field for the file is Y, you must give the 
configuration file a new name, even if the file you are 
using is your own custom file. If the InUse field for the file 
is N, you can either use the same name or give it a new 
name. Changing the description in either case is optional. 

The name and description can be up to 20 characters each. 
If another user is saving the same file using the same 
name, CAM processes only one of the commands, the 
other user receives an error message indicating a duplicate 
name.

7 Click Save. You are returned to the Configuration File Manager main 
dialog box. The list of files includes the file you just 
created.

You can now select this template when you create or 
modify this type of device.
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Figure 8-23 Configuration File Manager—Edit Dialog Box

Updating a Configuration File
Updating a configuration file allows you to update any shelf or System Controller to use the 
configuration file that you select from the list. If the configuration file is in use, you cannot 
update it.

For a summary of the options available in the Configuration File Manager for containers 
and devices, see Table 8-8.
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To update the configuration file:

Step Description

1 Select a System Controller or 
shelf from the Device Tree 
View.

The System Controller or shelf for which you want to 
update information.

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the device selected in the Device Tree View.

3 Click Configuration File 
Manager.

The Configuration File Manager dialog box appears. (See 
Figure 8-21.) 

4 Select a configuration file from 
the list and click Update.

The Configuration File Manager Update dialog box 
appears with the configuration file content. (See 
Figure 8-24.) 

5 Select whether to save the 
configuration file currently 
loaded on the device, before 
the update.

If you want to save the configuration file currently loaded 
on the device, click Yes, and enter a file name in the File 
Name field. If you do not want to save the current 
configuration, click No. The default is No.

6 Select whether to execute the 
task now or later.

If you select now, proceed to Step 10. If you select later, 
you must define task information. The task information 
specifies when the download is to take place. The default 
is later. 

7 Enter the time you want the 
update task to take place.

You must ensure that there is a value in the year, month, 
day, hour, and minutes fields. It must be a time in the 
future.

8 Enter a task name. You must enter a task name. It can be up to 16 characters 
in length.

9 (Optional.) Enter information 
in the Comment field.

You can enter any information about the task that you 
want. You can specify up to 128 characters.
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10 Click OK. The selected configuration file is downloaded to the 
selected device. You are returned to the Configuration File 
Manager main dialog box. You might need to refresh as 
described in Step 11. 

11 Click Refresh to refresh the 
displayed information.

If you selected now in Step 6 and the update is successful, 
the displayed information is updated automatically. CAM 
displays a message indicating that the update operation 
was successful. The InUse field value becomes Y, 
indicating that the selected file is currently running on the 
device.

If you selected later in Step 6, the information is not 
automatically updated. You must click Refresh to update 
the displayed information. In addition, to determine that 
the update operation was successful, check the status of 
the scheduled task in the Task Manager. No message 
displays to indicate the update operation was successful. 
See “Refreshing Your System” section on page 2-7 for 
details.

Step Description
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Viewing History of a Configuration File
Figure 8-24 Configuration File Manager—Update Dialog Box

Viewing History of a Configuration File
Viewing the history of a configuration file allows you to view all the records of changes that 
have been made to the configuration file on a per-device basis starting from the first 
download. 

For a summary of the options available in the Configuration File Manager for containers 
and devices, see Table 8-8.
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To view changes:

Step Description

1 Select a System Controller or 
shelf from the Device Tree 
View.

 The device for which you want to view history.

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the device selected in the Device Tree View.

3 Click Configuration File 
Manager.

The Configuration File Manager dialog box appears. (See 
Figure 8-21.) 

4 Click View History. The Configuration File Manager History dialog box 
appears with records of all the changes to the 
configuration file for the selected device. (See 
Figure 8-25.) 

5 Click Done. You are returned to the Configuration File Manager main 
dialog box.
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Deleting a Configuration File
Figure 8-25 Configuration File Manager—History Dialog Box

Deleting a Configuration File
You can delete a configuration file that you have either imported or renamed and edited. If 
the configuration file is in use, you cannot delete it.

For a summary of the options available in the Configuration File Manager for containers 
and devices, see Table 8-8.

Caution  If you delete a configuration file, you cannot recover it.
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To delete a configuration file:

Figure 8-26 Configuration File Manager—Main Dialog Box

Step Description

1 Select a System Controller or 
shelf from the Device Tree 
View.

The device for which you want to delete a configuration 
file.

2 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the selected device.

3 Click Configuration File 
Manager.

The Configuration File Manager dialog box appears. (See 
Figure 8-26.) 

4 Select the file you want to 
delete and click Delete.

The configuration file has been removed from the listed 
files.
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Using the Task Manager
The Task Manager helps you to manage the scheduled tasks in CAM. The Task Manager 
supports the following tasks:

• Viewing Task Output on page 8-63

• Deleting a Task on page 8-65

You do not add tasks for scheduling at the Task Manager dialog box. You add a task by 
means of other operations in CAM. Table 8-9 lists the CAM operations that allow you to 
schedule a task and have it managed by the Task Manager.

Table 8-9  User-Scheduled Tasks

Operation Container/device Operation Code in CAM

Configure>Delete Stack Delete Stack

System Controller Delete System Controller

Shelf 
(Cisco AS5300, 
Cisco AS5800, 
Cisco 7206, 
Catalyst 5002, 
Cisco 3640)

Delete Shelf

Configure>Modify Stack Modify Stack/Shelf 

System Controller Modify System Controller

Shelf 
(Cisco AS5300, 
Cisco AS5800, 
Cisco 7206, 
Catalyst 5002, 
Cisco 3640)

Modify Stack/Shelf
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Configure>Add System Controller Add System Controller

Shelf 
(Cisco AS5300, 
Cisco AS5800, 
Cisco 7206, 
Catalyst 5002, 
Cisco 3640)

Add Shelf

Tools>IOS Image>Update Group Load IOS Image

System Controller Load IOS Image

Shelf (Cisco AS5300 
and Cisco AS5800)

Load IOS Image

Tools>IOS Image>UpdateAllDefault Stack Load Default IOS Image

System Controller Load Default IOS Image

Tools>ModemImage>Update Group Load Modem Image

Shelf 
(Cisco AS5300, 
Cisco AS5800, 
Cisco 7206, 
Catalyst 5002, 
Cisco 3640

Load Modem Image

Tools>ModemImage>UpdateAllDefault Stack Load Default Modem Image

Tools>Configuration File>Update System Controller Load Config File

Shelf 
(Cisco AS5300, 
Cisco AS5800, 
Cisco 7206, 
Catalyst 5002, 
Cisco 3640)

Load Config File

Table 8-9  User-Scheduled Tasks (Continued)

Operation Container/device Operation Code in CAM
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In addition to user-scheduled tasks, CAM supports 11 internal tasks, 3 ReportInternal tasks, 
and 8 OtherInternal tasks. CAM displays and executes tasks in chronological order, by their 
scheduled start time at the Task Manager dialog box. However, if user-scheduled tasks are 
scheduled to execute at the same time, CAM executes them one after the other in random 
sequence. If ReportInternal tasks, OtherInternal tasks, and user-scheduled tasks are 
scheduled to execute at the same time, CAM executes them simultaneously.

Note The task status information at the Task Manager dialog box does not update 
automatically.You must click the Refresh button to update the status. 

If a system crash occurs, the status of all tasks is reset to scheduled after recovery. CAM 
then executes them in chronological order.

You can use the Tasks Manager for:

• Viewing Task Output

• Deleting a Task

Figure 8-27 shows the main dialog box for the Task Manager. 
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Figure 8-27 Task Manager—Main Dialog Box
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Viewing Task Output
Table 8-10 lists and briefly describes each of the fields that display on the main dialog box 
of the Task Manager. 

Table 8-10 Task Manager Fields

Viewing Task Output 
You can view task output of a configuration task only if it has failed. 

To view task output:

Field Name Description

number Number CAM assigns to the task file. Starting number is 1.

User Name Name of the user who has scheduled the task. A user with 
Administrator privileges can see all scheduled tasks, including 
internal tasks. All other users can see only those tasks they have 
scheduled.

Task Name Name assigned to the task automatically or by the user who has 
scheduled the task.

Scheduled Time The time at which the task has been scheduled to execute.

Device Name Name of the device on which the scheduled task is to occur.

Operation The internal operation code of the scheduled task. 
(See Table 8-9.)

Status Task status that indicates whether the task has succeeded or is 
scheduled.

Comments Optional description or comment.

Step Description

1 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the selected device.

2 Click Task Manager. The Task Manager dialog box appears. (See Figure 8-27.) 
This dialog box is not device specific.
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Figure 8-28 Task Manager—View Task Output Dialog Box

3 Select the failed task for which 
you want to view output and 
click View Output.

The Task Manager View Output dialog appears. (See 
Figure 8-28.) 

If a scheduled shelf deletion fails because its stack is gone, 
the View Output dialog box does not reflect this failure.

Step Description
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Deleting a Task
You cannot delete an internal task or tasks in the InProgress state. You can only delete tasks 
that you have scheduled. In addition, tasks that you have scheduled continue to display at 
the Task Manager dialog box until you manually delete them. However, internal tasks that 
have succeeded are deleted from the Task Manager dialog box automatically; they are 
replaced by the next task in the scheduled state. 

To delete a task:

Step Description

1 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the selected device.

2 Click Task Manager. The Task Manager dialog box appears. (See Figure 8-29.) 
This dialog box is not device specific.

3 Select the user-defined task 
you want to delete and click 
Delete.

You are returned to the Task Manager main dialog box. 
The task has been removed from the listed tasks.
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Figure 8-29 Task Manager—Main Dialog Box
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Using the User Account Manager
The User Account Manager helps you to manage CAM users. The User Account Manager 
supports the following tasks:

• Adding a user

• Modifying a user

• Deleting a user

The privileges defined at the User Account Manager dialog box determine the possible 
operations a user can do at the various CAM dialog boxes. The User Account Manager 
dialog box lists all users in addition to their respective passwords and privileges currently 
defined in CAM.

If you have administrator privileges, you can use all dialog boxes without restriction. You 
must have administrator privileges to use the User Account Manager. If you have 
administrator privileges, you can add, modify, and delete users at the User Account 
Manager dialog box. Additionally, you can set the user name, password, and read-write or 
read-only privileges for each CAM user. 

If you have read-only or read-write privilege, you are restricted. The read-only privilege 
prevents you from creating or making changes at any of the dialog boxes in CAM. 
read-only users have access only to monitor and report dialog boxes. The read-write 
privilege limits a user to adding or editing his/her own settings. Read-write users have 
access to all dialog boxes except the User Account Manager dialog box.

If you do not have administrator privileges, the User Account Manager is not visible to you.

Table 8-11 User Account Manager Fields

Field Name Description

User Name Name of the user who you want to add, modify, or delete.

Password Password assigned to the user name.

Privilege Privilege assigned to the username. 
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Adding, Modifying, or Deleting a User
You can add, modify, or delete a CAM user at the User Account Manager dialog box. You 
can modify a user’s name, password, or privilege, and you can delete a CAM user, but you 
cannot delete the administrator. You must have administrator privileges to use the User 
Account Manager. 

To add, modify, or delete a user: 

Step Description

1 Click Tools. The Task Selection bar displays all of the tasks CAM can 
perform for the selected device.

2 Click User Account Manager. The User Account Manager dialog box appears. (See 
Figure 8-30.) 

3 Enter a username, or select the 
user account you want to 
modify or delete.

The username can be up to 64 characters. When you enter 
a username, the Add button becomes enabled.When you 
highlight an existing username in the list, the Modify and 
Delete buttons become enabled.

4 Enter a password. The password can be up to 64 characters.

5 Select a privilege. The possible privileges are read-only and read-write. The 
default privilege is read-only. A user with read-only 
privileges cannot make any changes at the CAM dialog 
boxes. A user with read-write privileges can make 
changes, but not to other users. 

If the logged-in user has read-only or read-write 
privileges, the information displayed at the dialog boxes 
relates to only the logged-in user.

6 Click Add, Modify, or Delete. The user is added, modified, or deleted.
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Adding, Modifying, or Deleting a User
Figure 8-30 User Account Manager—Main Dialog Box
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